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LIGHTROOM CLASSIC LIBRARY WINDOW 

JOHN TAYLOR 

This second article on Lightroom Classic covers the Library window, which is where you organise your photo 

files and edit the images’ metadata. Please read my article STARTING WITH ADOBE LIGHTROOM CLASSIC if 

you have not already done so. Remember that Lightroom Classic works with the Catalogue file on your hard 

disc, which is where all your editing (metadata changes and development) is stored.  

This article only applies to Lightroom Classic and not the cloud based Lightroom. Lightroom Classic is far more 

powerful for organising your photos than Lightroom.  

Go through this article with Lightroom Classic open, so you can try out each feature as you go.  

 

When you open Lightroom Classic it will go by default to the LIBRARY MODULE. You should see this with 

LIBRARY highlighted in the CONTROL STRIP at the top of the Library window. If you can’t see this control strip, 

click on the little triangle at the top centre of Lightroom Classic’s window. Clicking on the other labels will take 

you to other modules: Develop, Map, Book, Slideshow, Print and Web. Pretty much all the work you do in 

Lightroom Classic is in the Library and Develop modules. You can hide or reveal modules listed in the control 

strip by Right/Control clicking on the strip and checking which modules you use. If you don’t own a photograph 

printer and get all your printing done at a photofinisher, the Print module is of limited use to you. I have never 

found the need for the Web module. 

Type G to return to the Library GRID VIEW (as above), or E to go to LOUPE VIEW.  
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LIGHTROOM CLASSIC ’S PANELS  AND THE FILMSTRIP 

This section applies to all Lightroom Classic modules, not just the Library module. At the left and right sides of 

the window there are a group of individual Panels, which can be opened and closed by clicking the flippy 

triangle in the panel header. Each panel contains a mini module. 

You can widen or narrow each of the panel groups by clicking and dragging its inside border. Type Tab to show 

or hide the panel groups, allowing more space for your images. If you type Shift-Tab, all the panels and bars 

disappear and your image window fills the screen. Alternatively click on the little triangles at the sides of the 

screen to show and hide each panel group.  

Click the little triangle at the bottom centre of the window to show or hide the FILMSTRIP, which shows the 

images in the selected folder. I don’t find the filmstrip of much use in the Library Module, but it is very useful 

in the Map, Book and Slideshow modules.  

You can hide panels you don’t use or unhide those you need by Control Clicking or Right Clicking on any panel 

name. A dropdown menu will appear and you can select or deselect panels. Check Solo Mode so that only one 

panel is open at a time. When you open another panel, the previous one closes.  

You can highlight the main image window by typing L. This will cycle through Lights Out, Lights Dim and Lights 

On views. This can also be done by MENU: Window > Lights Out 

THE TOOL BAR 

Underneath the image window in any module is the TOOLBAR. Type T or Menu: View > Show/Hide Toolbar. 

What is shown in the toolbar depends on the module you are working in.  

GRID AND LOUPE VIEWS IN THE LIBRARY MODULE 

Selecting a folder of images in the Folders Panel will show all the images in this folder in the image window. 

GRID VIEW shows thumbnails for of all the images, and if there are a lot of images in the selected folder, a 

scroll bar allows you to see them all. Type G to go to Grid view, or click on the left ikon in the Toolbar. Clicking 

on a single image highlights it (the border is lighter). Shift-clicking or dragging over images in Grid view can 

select a group of images, one of which is lighter showing it is active. Command/Control clicking on individual 

images will add them to the selection. Notice how the borders around the image change the tone of grey with 

selected images. For film buffs, Grid View is like looking at negatives or transparencies on a light box.  

The Default TOOLBAR under the photo images in Grid view shows from left to right, the five alternative view 

modes, the Painter spray can, a dropdown menu to select different ways of sorting images, a triangle which 

initiates a slideshow, and a slider to adjust the thumbnail size. On the right-hand side is a flippy triangle which 

reveals a menu of options which when checked will appear on the toolbar. You can make the thumbnails 

smaller or larger by dragging the slider in the toolbar or with the keystrokes Control – or Control + (Right-click 

with a 2-button mouse is the same as Control click) 

LOUPE VIEW shows a single image in the image window. Photographers using film examine negatives or slides 

on the lightbox with a magnifying loupe. Type E or click on the second left ikon in the Toolbar to select Loupe 

view. When in Loupe View, you can use the arrow keys to scroll through the images you selected in Grid View. 

The Toolbar in Loupe view has a different set of default tools. It has a flippy triangle on the right showing the 

menu of options available.  



 3 

VIEW OPTIONS 

In Grid or Loupe View, Right/Control click on an image and a fly-out menu will appear with lots of options. One 

of these is LIBRARY VIEW OPTIONS. Alternative ways to open the View Options Dialogue box are MENU: View 

> View Options, or type Control/Command J. A DEVELOP VIEW OPTIONS dialogue box can be accessed if you 

are working in the Develop Module.  

In View Options, you can select what metadata is shown with each image. The default view for Compact Grid 

view is File name, flags, rating and colour code, but you can select an Expanded view to see more, or change 

what is shown. In Loupe view, I like to see aperture, shutter and ISO, along with lens.  

ORGANISING YOUR IMAGES INTO FOLDERS 

The FOLDERS Panel in the left-hand group of the Library module is where you see and organise the disc 

drives, folders and image files that you have imported into Lightroom Classic. When you organise files and 

images in the Folders panel, your changes are being made in Apple Finder or Windows Explorer. You only see 

the files and folders you have imported into Lightroom Classic, giving an uncluttered view. Clicking on a folder 

name will show the images in it.  

Click the + sign at the top of the Folders Panel to add a new folder inside the active folder. A dialog box will 

allow you to name your new folder. This will also create a new folder in Windows Explorer or Apple Finder.  

With a folder highlighted, click the – sign in the Folders Panel header to delete that folder and its contents 

from the catalogue, but this does not delete files from Finder or Windows Explorer unless there is nothing in 

the folder. If you want to delete a folder containing files, you have to do this in Explorer or Finder. This is 

because the folder may contain files that Lightroom Classic cannot recognise. You can delete images in a 

folder, and then if there is nothing else in the folder, delete the folder.  

Drag and Drop folders in the Folders panel to rearrange them, putting them inside another folder, or moving 

them and their contents to another disc. Images can be moved from one folder or drive to another by 

selecting them in Grid view and then dragging and dropping to another folder. You can also use MENU: Edit > 

Cut and Paste to move selected folders or images around. Lightroom Classic does not allow you to duplicate 

images, but really you only want one copy, otherwise you will end up confused.  

Always use the above methods to rearrange your images in folders. If you do this 

in Windows or Finder, Lightroom Classic will lose track of where the images are.  

If this occurs, Lightroom Classic will indicate an image can’t be found with an exclamation mark (!). Just click on 

the exclamation mark, then navigate to it in Lightroom Classic to put it in the catalogue. Alternatively, in 

Finder/Explorer, move the image back where it should be.  

Just below the Folders module header is the FILTER FOLDERS dialogue box with a little magnifying glass ikon. 

Start typing in this box to search for a particular sub-folder’s name. Really cool eh!  

RANKING YOUR IMAGES IN THE LIBRARY WINDOW  

You can see your images as small thumbnails in Grid View, but you really want to critically examine each one 

individually, rejecting the failures and identifying the heroes for development.  

To see the active image fill Lightroom Classic’s image window, (Loupe View), hit the spacebar, type E, or 

double click on the image.  
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Type Z or hit the spacebar to toggle full screen or zoomed into 100%. Control/Command + or – will zoom in or 

out too. In Loupe view, move to other selected images with the Tab or Left and Right arrow keys. When 

zoomed in you can navigate around the image by dragging the rectangle in the Navigator window.  

Type F (Full screen view) to make the active image fill the whole screen – without the info shown in Loupe 

view. Type F, E or G to return to Library View. HINT: Look at the final image in full screen view, when you have 

finished Development to check for distractions. I have found the Info panel distracts from making a full 

examination.  

On the left of the Toolbar are 5 ikons that give different views of your images. Select several images, then click 

on each ikon. From Left to Right the views are Grid view (Type G), Loupe view (Type E), Compare to View (Type 

C), Survey View (N), and People view (O).  

COMPARE VIEW allows you to compare one or more images against a hero. SURVEY VIEW allows you to 

compare two or more images, but no one is designated a hero. The PEOPLE view shows images containing 

faces with a box around each face. You can name a face and this name will be added as a keyword. See 

Keywords later.  

IMPORTING A SESSION’S IMAGES  

Both Nick Melidonis and I recommend the following method to load and process images into Lightroom Classic 

after each session or day. Images are downloaded from your camera, the duds discarded, the heroes identified 

for development, keywords are added. Putting all the images from one session in their own folder keeps things 

tidy and helps your workflow. See my notes on “Development Software Overview” for my thoughts on folder 

structure.  

 

Import Window 

When you connect your camera or card reader to your computer and Lightroom Classic is open, it will usually 

open the IMPORT WINDOW. If not, click the IMPORT button at the bottom left of the Lightroom Classic 
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window. You should see the name of the camera card in the Source list on the left. Select this if it is not 

already selected. You work the import window by going from left to right.  

Choose COPY to copy the files from your camera card, leaving the originals on the card as a backup.  On a long 

trip, I make sure I have enough cards for all the trip’s images,  

On the right at the top will be indicated the disc where the files will be copied. Below are the File Handling, File 

Naming, Apply During Import, and Destination Panels.  

In the FILE HANDLING Panel, I use the following settings.  

• Build Previews – Embedded & Sidecar. This setting affects the size of previews and how long they take 

to build. See Lightroom Help for more detail.  

• Don’t import Suspected Duplicates – Checked.  

• Make a second copy to – off. Turn on if you want to copy a backup to a connected hard drive. 

• Add to a Collection – off.  

Click Uncheck All, then select the images you want to import and check one of those to effectively check all 

selected images.  

The FILE RENAMING panel gives a great way of naming your images, if this is part of your workflow.  

The APPLY DURING IMPORT Panel gives you the ability to do repetitive work on every image. DEVELOP 

SETTINGS allows you to apply a Development Preset to every image as it is imported. This can add a 

development profile, ensure lens aberrations are corrected, apply noise reduction and sharpening. The latest 

versions of Lightroom Classic enable you to create a profile that will vary noise reduction and sharpening 

depending on the image’s ISO setting. See more in my article on Development for how to create such a profile. 

You can also add metadata(such as a copyright notice and keywords to each image on import.  

The DESTINATION PANEL allows you to specify where the images go on import, including the option to create 

and name a new subfolder for them.  

You can save the settings in these panels by creating an IMPORT PRESET in the panel at the bottom of the 

window. This is useful if you have more than one camera.  

Finally click IMPORT to complete the import. Lightroom Classic will copy the images from the card and build 

thumbnail images to show in the Library Grid View.  

RATING, FLAGGING AND COLOUR CODING YOUR IMAGES.  

Your new folder of images will appear in the Library window as a PREVIOUS IMPORT group in Grid View, but 

you can navigate to any folder of images using the Folders Panel.  

If you have groups of images taken at the same time (Bracketed images or motor-wind images), you can stack 

images together for convenience. MENU: Photo > Stacking > Auto-stack by Capture Time. Drag the slider to set 

how many images are grouped together.  

After importing a session’s images, I look at each one in Loupe view, using the keys Spacebar, E, G and Z to 

zoom in and out of the image. Images are rated using stars. The type keys numbered 1 to 5 are used to star-

rate each image. Alternatively, the star rating tools in the Toolbar can be used. As a first go, I rate ones I have 

seen with 1 star (Type number 1), and the promising images with 2 stars. Any bad images (out of focus, miss-

timed or other faulty images) are flagged rejected (Type X). Use the right arrow key to go to the next image. 

Any I have not reviewed will have no stars.  
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For groups of similar images, such as  in a motor wind group, I use the Survey View. Select the group of similar 

images and type N. Type X to reject all the images. Starting with the first image Type E to review it full screen, 

X to zoom in and check sharpness. In Survey View, clicking the cross in the bottom left of its ikon will remove 

the rejected image from the group. In Survey View clicking a reject flag will cancel rejection of the remaining 

images. I use a similar process to select one or two hero images. In Survey View type 2 to give them all 2 stars. 

Checking each individually in Loupe View enables selection of the best images, which are then removed from 

the group in Survey View by clicking the X. Finally in Survey View type 1 to set the runners-up to one star.   

I use colour coding to mark images in a focus stack, HDR or panorama group, so that I can easily develop the 

group together. The number keys from 6 to 9 give different colour codes. The zero key will clear any stars and 

colour codes of selected images.  

When you rate, flag or colour code an image, you are adding to its metadata and make it easier to locate.  

After going through all the images in a file, delete the images flagged rejected. MENU: Photo > Delete Rejected 

images. The default of this only removes images from the catalogue. Choose the “Delete from disk” option to 

put them in the Trash.  

I flag any remaining images by selecting them all and hitting the ` key. This flag shows them as my master 

images. If I export an image to a subfolder, the exported image will not be flagged. If I develop an image with 

Photoshop it can then be flagged as the master image, and the flag of the RAW file turned off.  

FILTERING TO SHOW ONLY YOUR BEST IMAGES  

Now you have chosen your heroes, you can hide all the others. In Grid View, immediately above the images is 

the LIBRARY FILTER Bar. Type Backslash (\) to show or hide this bar, or MENU: View > Show Filter Bar. Mouse 

down on Attribute, then click on the two stars. Now all the zero and one-star images are hidden, so you only 

see or your heroes. Click None to see all your images again. More on the Library Filter Bar later – it’s powerful! 

KEYWORDS 

Keywording is one of the most powerful ways of adding metadata to images so they can be found easily. It is 

best to consider your strategy for applying keywords at the start so that you can make best use of it.  

When you are starting with Lightroom Classic, there will be few keywords in the system. To create a new 

keyword, Click the + sign in the Keyword List Header and the CREATE KEYWORD TAG box will appear. If you 

have selected a group of images, you will be given the opportunity to tag all the selected images. As you create 

a new keyword you have the option of adding synonyms. My father’s name is Cyril, but I can add the synonyms 

Dad or CWT to enable these terms to be used to find images of him. To edit an existing keyword, double click a 

keyword name to reopen the Create Keyword Tag dialog box.  

Keywords can be nested one inside another (drag and drop). So, it makes sense that you use this feature for 

example for Places: Country, state, region, town, suburb. Therefore, you can have main categories of 

keywords, with keywords nested inside the main categories.  

• People – relationship (Family, Friends, MPC members, Models), names 

• Places – Country, state, region, city or national park, suburb 

• Events – MPC, family, parties, weddings, workshops, WAPF 

• Animal – farm, wild, apes, gorillas, birds, pelican 

• Plant life – flowers, fruit, foliage, trees, biological name (common name can be a synonym) 

• Genre – landscape, portraiture, family, seascape, still life, night shots, weather, urban, transport 
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• Sport – Powerboats, Sailing, Drag racing, surfing, BMX 

• Technique – motion blur, flash, focus stacked, panorama stitch, HDR, filters 

• For composites – Textures, Skies 

Use keywords that reflect your photography. Each keyword should find a reasonable number of images. For 

example, if you visit a country once for a short visit, and there are a hundred or so images. Then you don’t 

need to have keywords for each city. However, you probably need a keyword for each of the suburbs or 

localities around Mandurah, because a search on your home town will find a huge number of images.  

To apply existing keywords to a folder of images, firstly in Grid view, select images that you want to all have 

the same keyword. Keywords are best applied using the KEYWORDING panel. Just start typing the keyword, 

and it will suggest ones that already exist. The panel has KEYWORD SUGGESTIONS that you can click on to 

apply the keyword. You can also set up KEYWORD SETS.  

You can also apply a keyword using the KEYWORD LIST panel. You can scroll down to find the keyword you are 

after, but it is better to start typing in the keyword filter box. This reduces the number listed to speed up 

finding the one you want. To the left of the keyword is a check box. Clicking in this will add the keyword to all 

the selected images.  

Keywording is a tedious task, but Lightroom Classic has a number of features to make it as easy as possible. 

Check out Lightroom Classic’s help by searching on Keywording to get more helpful hints. To find images in 

your library that are not keyworded, look at the existing Smart Collection > Without Keywords. Alternatively 

use the Library Filter Bar (see below). 

THE PAINTER (SPRAY CAN) 

The other way you can apply a keyword in Grid View is using the PAINTER in the Toolbar. Click on the spray 

can ikon. In the Paint dropdown menu that appears, choose Keywords. Click the sample box to highlight it, and 

start to type your Keyword. It will list existing keywords as you type and you can select the one you want. 

Move your curser, which will look like a spray can, over a selected image and click. All the selected images will 

be given the keyword. If necessary, you can click on individual unselected images to apply the keyword.   

You can use Painter for other tasks, such as applying a flag, label, rating or rotating images in a similar way.  

PEOPLE 

Lightroom Classic has face recognition software that works reasonably well, depending on the age range of 

your subjects. In the Toolbar below the images, click on the People ikon to select the People view. Click on the 

image in the Navigator window to view the whole image. Each face that Lightroom Classic recognises in the 

image will have a box around it and a suggested name.  Either accept the suggested name or start typing the 

correct name for each person. The more tagged images of a person there are, the better face recognition will 

work. If you don’t know the name, or if a statue or other artefact is chosen, delete the face box. Add face 

boxes if Lightroom Classic did not generate one. The names will appear in your keyword list.  

If you had a folder selected, you will see a screen showing the named and unnamed people in the folder of 

images you are working on. You can work in this window too.  

Often faces you don’t know will be found. The suggestions can be funny, particularly when Lightroom Classic 

tries to name something not human. Enjoy going through your images.  
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METADATA PANEL 

Lightroom Classic will show all the metadata captured by the camera and added during image processing, as 

well as metadata you add to an image in the Metadata Panel. The dropdown menu next to the Metadata Panel 

header gives you choices of which metadata to show.  

You can for example add an image title, or change metadata by clicking on an item in the list and typing.  

You can change the file name of an individual file by clicking in the File Name box to select the type and 

retyping. You can rename a number of files in a folder by selecting them, and then clicking on the button to 

the right of the File Name box. You will be given the opportunity to rename the images as a sequence, for 

example TEXT 0001, TEXT 0002 and so on.  

If your camera does not have GPS, then you can add this. Use your smartphone to take an image at the same 

location. Cut and paste the GPS data from your smartphone image to the GPS panel of your camera’s images 

taken at this location. Now Map View will show where your images were taken.  

SEARCHING FOR PARTICULAR IMAGES 

In Grid View (G), there are two ways of searching for images that match particular criteria.  

FROM THE KEYWORDS AND METADATA PANELS  

In the Keywords and Metadata Panels on the right-hand side of the Library module, there is a button with an 

arrow to the right of searchable items. Clicking on this will give a grid view of all files in the catalogue which 

match the selected metadata or keyword. Remember to search the keyword list, start typing your keyword in 

the Filter Keywords bar.  

This method only searches the whole catalogue, and only on the one metadata type. The Library Filter Bar is a 

more powerful search tool.  

LIBRARY FILTER BAR 

The Library FILTER BAR above the images in GRID VIEW (Type \ to toggle visibility) can be used to search for 

particular images in a more sophisticated way than the one described above. Choosing a particular disk drive 

or folder restricts the search to images in this drive or folder. You can choose more than one criteria to search 

by, and so narrow your search.  

From the Filter Bar’s Menu list, click on TEXT to search on File Name, Copy Name, Title, Caption and Keyword  

Click on Attribute to search for images which are flagged, marked as rejected, rated higher or lower or equal to 

a set star rating, with or without a colour code, edit status (developed/undeveloped), whether they are master 

images, virtual copies, or videos.  

Click on Metadata to search on searchable metadata, including particular keywords from your list or no 

keyword, camera, lens and label.  

Using this tool, I can search for all images on a particular drive, with the word Greenland as part of the 

Keyword, with 2 stars or more, taken by a particular camera and lens. They can be further filtered by date. It 

can lead to some unexpected results. ‘Greenland’ chooses not only the images I took in Greenland, but of 

Mark Greenland.  
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The latest version of Lightroom Classic includes Date as an option in the metadata list. In this way you can 

narrow your search to a particular date range.  

COLLECTIONS 

Collections are way of grouping images you want to view or work on together. A collection can include images 

scattered throughout your library. It is a virtual folder – the images are really still in their original locations. 

You can edit an image in a collection and you are editing the original and not a copy.  

Create a new collection by clicking the + button in the Collections Panel header and typing in a name. Add 

photos to a collection by dragging and dropping. Show the images in the collection in Grid or Loupe view by 

clicking on its name.  

I create a collection when I put together a number of images to go into a competition or portfolio. Clicking on 

the collection name shows just these images in Grid view. If you want to create a Photobook or Slideshow, put 

those images you want to include in a collection. Images can be removed from a collection by selecting them 

and using the Delete key. The images will only be removed from the collection, and will still be in their original 

folder. If you want to bin a photo in a collection, Right-click on the image to take you to the original folder.  

Smart collections are set up using metadata, such as star rating, colour code or image size. For example, I give 

all my Gold and Silver Awarded images 5 stars. A Smart Collection of 5 stars will have my awarded images. 

WAPF competition organisers, and club Competition Directors use smart collections to find photographs that 

don’t conform to the competition rules for image size and date range. You could do the same.  

WORKING WITH CLOUD BASED LIGHTROOM 

Lightroom is now a cloud based application and is available for laptops, desktops, smartphones and tablets. It 

can work images in the Adobe Creative Cloud, in the following ways: 

• Images can be transferred from your camera card to the cloud using Lightroom. 

• Images in the cloud can be edited by Lightroom using your tablet, smartphone or computer.  

• Cloud images can be synchronised with Lightroom Classic. The Cloud Ikon in the top right corner of 

Lightroom Classic’s Library window can be used to turn off or on synchronisation. It also shows the 

amount of cloud storage used. Synchronisation means edits can be made to these images using 

Lightroom or Lightroom Classic.  

• Images in the Adobe Creative Cloud can be copied to your hard drives using Lightroom Classic. They 

can then be deleted from the cloud so they don’t take up space.  

BUT THERE’S MORE! 

Explore Lightroom Classic’s extensive Help to find more features, for example:  

• Right-Click (Windows) or Control-Click (MacOS) on a folder’s name to add coloured labels to the folder, or 

to mark a folder as a favourite. Then the Filter Folders box can be used to find these folders.  

• If the folders catalogued in Lightroom Classic don’t match the folder when viewed in Explorer or Finder, 

you can synchronise them. MENU: Library > Synchronise Folder, or Right-Click / Control-click on a folder’s 

name and select Synchronise. You can add to the catalogue images in the folder that are not catalogued, 

or remove from the catalogue images that you trashed in Explorer or Finder.  

• To explore what a disk or volume holds as catalogued photos, Right-Click on the volume name. The default 

shows the number of photos, but you can also select how much disk space is used or whether the disk is 

on-line or offline.  
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WHAT IS NEXT 

In the article DEVELOP MODULE, I will describe how you develop images in Lightroom Classic. I will also 

describe how you can develop multiple images at the same time. I will also cover how to export images as files 

for digital or print competitions.  

The Article CLOUD BASED LIGHTROOM covers how to use Lightroom with your smartphone tablet or 

computer. It describes how to import images from your camera to Adobe’s Creative Cloud, develop them, and 

transfer them to your hard drive.  

Now you have started to add to your catalogue file, review my article STARTING WITH LIGHTROOM CLASSIC 

to find an overview of the catalogue file, where it is, and how to back it up.  

Both Lightroom and Lightroom Classic have excellent training videos, showing how individual photographers 

develop their images. Go to the Help menu in Lightroom and explore what else you can do.  

Things you should look up in the Lightroom Classic help are:  

• Restoring your catalogue from a backup 

• Renaming files and folders 

• Lightroom Classic Maps module 

• Lightroom Classic Slideshow and Books modules 

Thanks to Nick Rains and Nick Melidonis for their help introducing me to Lightroom Classic.  

15 December 2021 
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